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Chapter 1: Introduction
The Crown® Power Amplifier provides the user with the power to drive passive audio loudspeak-
ers. Each amplifier is a network component that integrates with ASTi’s ACENet. ACENet pro-
vides a low latency, network based audio and I/O distribution architecture for ASTi’s Telestra 4 
ACE communications and sound modeling equipment and software. The amplifier offers a full 
range of indicators for accurate diagnostics. This document provides an overview of the CT 4200 
4-channel amplifier in a 2U chassis and the CT 8200 8-channel in a 3U chassis. For a more com-
prehensive understanding of the Crown® products please read the documents listed in the Refer-
ence section of this document. 

Telestra 4

CAT 5
Ethernet

8-Channel ACENet Amplifier

Advanced Simulation
Technology, Inc.

CAT 5
Ethernet

ACENet Switch

Figure 1: System Setup 
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1.1. Dimensions

Crown 
Amplifier

Depth Width Height

CTs 4200 16.25 In.
41.3 cm

19 In.
48.3 cm

3.5 In.
8.9 cm

CTs 8200 16.25 In.
41.3 cm

19 In. 
48.3 cm

5.25 In.
13.3 cm

CTs 4200 4-Channel Crown Amp

Figure 2: 4-Channel Front View
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Figure 3: 4-Channel Rear View
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CTs 8200 8-Channel Crown Amp

Figure 4: 8-Channel Front View
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Chapter 2: Getting Started 
WARNING: Before amplifier installation, ensure that your amplifier is not con-
nected to power and all control levels are turned down (counter clockwise). 

 

2.1. Proper Cooling

Do not block any of the amplifier ventilation vents. When using an equipment rack, mount the 
units directly on top of each other. Do not block rear, front, or side air vents. The side walls of the 
rack should be a minimum of two inches (5.1 cm) away from the amplifier sides, and the back of 
the rack should be open.
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2.2. ACENet and Crown Power Amplifier Operation and Configuration 
Process

Each power amplifier connected to a Telestra 4 Target forms part of the ASTi networked ACENet 
audio distribution architecture, and hence behaves a little differently from a simple analog power 
amplifier at start-up. 

In order to utilize the network features of the amplifier it is necessary for the Target to recognize 
the amplifier, and then configure the amplifier for correct operation. This process takes a short 
while to complete, and the user needs to be aware of this, otherwise the lack of immediate opera-
tion may be misinterpreted as a system failure or similar. 

In order to understand this, follow the quick top-level overview of the ACENet and Crown power 
amplifier operation and configuration process:

• When a Target system boots up it starts a number of background processes, one of which 
scans the ACENet network for Crown power amplifiers.

• If it finds an amplifier, it determines whether or not this is configured for ACENet opera-
tion. There are two possible states “configured”, or “not configured”.

• An amplifier that has been powered off will report as “not configured”, while an amplifier 
that has been configured and left powered on (irrespective of the state of the Target) will 
retain the original configuration.

• The time taken to perform the configuration will be a function of the number of amplifiers 
and the number of channels, and will take upward of 90 seconds to complete. 

• During the configuration period the amplifier(s) will appear inoperative, and will not pro-
duce sound.

• The system will monitor the state of all amplifiers ‘registered’ with a Target during run 
time. However it should be noted that the process performing this monitoring is scheduled 
periodically (approximately once every 60 seconds) and therefore, if an amplifier is pow-
ered off (perhaps to perform some maintenance function), it is necessary to ensure the 
amplifier remains powered off for at least 60 seconds, such that on power-up the configura-
tion process can re-discover the amplifier and initiate the correct configuration commands. 

• The system will perform a configuration check of all connected power amplifiers every 24 
hours, and any misconfiguration will be corrected as part of the runtime check.*

• In any given ACENet configuration only one Telestra Target can use Crown amplifiers. 
Additional Telestra Targets can exist on the network but must be using ACU2s or ACE-
RIUs only. 

* It is worth noting that the system performs two levels of self-monitoring; every 60 seconds the 
system confirms that all the amplifiers it “recognized” previously are still present, any new ampli-
fiers receive a configuration download. While every 24 hours all registered amplifiers are interro-
gated for correct configuration, and any errors are automatically corrected.
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ASTi recommends that users limit themselves to the basic operation of the Crown power amplifi-
ers, however we do recognize that there are many sophisticated capabilities available within the 
embedded functionality of the amplifiers via the Crown HiQnet. Please contact ASTi before 
attempting to utilize any of the extended features of these amplifiers to ensure that there is no con-
flict with required ASTi configuration settings.

Caution: Manual selection of a ‘preset’ (via the rear panel ‘preset’ switch) will almost certainly 
cause the amplifier to cease communication with the Target (since the required ACENet configu-
ration data will not be available in the selected preset). While we discourage customers to use this 
capability, if this is done, the simplest resolution is to power off the amplifier for at least 60 sec-
onds, and then turn the amplifier back on, at which point the Target will reconfigure the amplifier 
to the required working configuration.
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2.2.1. Multiple Crown Amplifiers on the ACENet
All Crown amplifiers come pre-configured with the same IP address and when using two or more 
on the same ACENet network they will not function properly in the System Architect software 
until one IP address is changed. ASTi recommends changing all IP addresses if using multiple 
Crown amplifiers on the same ACENet network.

If you try to use two or more Crown amplifiers on a common ACENet network with the Harman 
Audio “System Architect” software to set-up the internal DSP features (filters, delay, power limit-
ing, etc.) it will only report that one amp is online via System Architect; the others will be 
“offline”. The software will find the amps, but all but one will be grayed out. The network trou-
bleshooter will repeatedly try to instruct you to reconfigure the network interface of the PC that is 
running System Architect.

There are two applications available from Harman Audio that will help resolve this issue:

1) System Architect via “Tools” and “Readdress Devices”

2) HiQnet NetSetter which is available at http://hiqnet.harmanpro.com/software/netsetter/

One amp should remain configured with the default IP address of 192.168.1.1 and set any addi-
tional amps with incrementing IP addresses (i.e. 192.168.1.2, etc.).
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2.3. Setup Procedure

 1. Connect the power cord into the AC Power Cord Connector. 

 2. Remove the Output Connector’s cover plate and connect the speakers to the output con-
nectors.    

 3. The dual RJ45 connectors allow a Primary & Secondary Ethernet port to the 100 Mbps 
Ethernet network. Use the Primary or Secondary port and a Category 5 cable to connect to 
the ACENet switch. 

 4. If using speakers higher than 8 ohms change the Mode Switch to 16/8, for most applica-
tions the mode switch can remain in the 8/4 setting. 

Note: Ensure the amplifier is powered off before changing the mode switch.

The Channel Level Controls act as the overall master gain control for each channel in all 
operational modes. As a starting point ASTi recommends that the Channel Level Controls 
be set to the ‘10 o’clock’ position. 

The Channel Level Controls are implemented rather counter-intuitively. With the ACENet 
digital input active, and a setting of 12 o’clock (control vertically up), 0dB gain is applied 
to the signal meaning a full-scale digital signal will demand full power from the amp. Set-
ting the control beyond 12 o’clock could cause clipping for any signal at or approaching 
full-scale which is definitely not recommended. Using the 10 o’clock setting as the start-
ing point ensures clipping is not allowed and limits the amp to approximately 50 watts of 
delivered power. If more power is required advance the control but do not exceed the 12 
o’clock setting under any circumstance. 

See section 3.2. Rear Panel Connections for more information. 

The Input Connectors are not used in the ASTi system setup. 

WARNING: Do not connect or disconnect speakers or ACENet while the amplifier is powered 
on.
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Figure 6: Rear Panel Connections
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2.4. Powering Up the Amplifier

Important: Complete section 2.1. Setup Procedure before proceeding with this section. 

When turning on the amplifier for the first time follow the steps below. 

 1. Turn down the levels of the audio source. 

 2. Turn on the Power switch. The power indicator should illuminate. 

 3. Turn up the audio source levels. 

 4. Once the amplifier is properly setup and connected to the network, use ACE Studio soft-
ware to complete the amplifier configuration. 

Remember: Disconnect the power cord before making any changes to the installation or wiring. 
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Chapter 3: General Information
3.1. Front Indication Lights

• Bridge Mode Indicator – illuminates yellow when the channel pair is set to the “Bridge” 
position. If the bridge mode is changed while the amplifier is powered on it must be pow-
ered off and back on to reset the mode. 

• Ready Indicator – illuminates green when the channel is initialized and ready to produce 
audio output. 

• Signal Indicator – illuminates green to indicate the presence of input signals above -
40dBu. 

• Clip Indicator – illuminates red when the THD of the channel’s output signal rises to a 
level typically considered as the onset of audible clipping. 

• Thermal Indicator – illuminates red when the channel has shut down due to thermal stress 
or overload.

• Fault Indicator – illuminates red when the output channel has stopped operating. 

• Power Indicator – illuminates blue when the amplifier is on and the AC power is available. 
This will also flash if the amplifier shuts off from under/over voltage conditions. 

• Data Indicator – illuminates yellow when a command is received by the module. 

Bridge Mode Indicator
Ready Indicator

Clip Indicator

Signal Indicator

Thermal Indicator

Fault Indicator

Data Indicator

Power Indicator
Power Switch

Figure 7: Front Panel Indication Lights
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3.2. Rear Panel Connections

Caution: Manual selection of a ‘preset’ (via the rear panel ‘preset’ switch) will almost certainly 
cause the amplifier to cease communication with the Target (since the required ACENet configu-
ration data will not be available in the selected preset). While we cannot imagine why a user 
would attempt to use this capability, if this is done, the simplest resolution is to power off the 
amplifier for at least 60 seconds, and then turn the amplifier back on, at which point the Target 
will reconfigure the amplifier to the required working configuration.

• AC Power Cord Connector – standard IEC type 320 inlet, 120V models are 15-amp, 220-
240Vmodels are 10-amp, voltage is indicated above IEC inlet.

• Output Connector – for every two channels there is a one four-pole strip with a touch-
proof cover that accepts up to 10 AWG terminal forks. 

• Primary and Secondary Ethernet Connection – connects to ASTi’s ACENet which pro-
vides low latency, network-based audio and I/O distribution architecture for ASTi’s com-
munications and sound modeling equipment and software. For more information on this 
flexible architecture and highly scalable distribution network please see the Telestra 4 
ACENet User Guide (DOC-01-TEL4-AN-UG-1). Please note only a single connection 
should be made between the amp and the upstream ACENet switch. 

• Mode Switch – for every two channels this switch selects the amplifiers mode including 
Dual 8/4 ohms, Dual 70V, Bridge-Mono 16/8 ohms, and Bridge-Mono 100V. 

WARNING: Ensure that the amplifier is powered off before changing the mode        
setting. 

• Input Connectors – removable Phoenix-style connectors for balanced analog audio signal 
input. The Input Connectors are not used in the ASTi system setup. 
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• Channel Level Controls – act as the overall master gain control for each channel in all 
operational modes. The exact setting required for any specific installation will depend on a 
number of factors including speaker placement, speaker sensitivity, size of the space being 
driven, and of course the required sound level required from the system.

Conventional audio set-up procedures apply, such that the signal source should be set to the 
maximum level achievable while avoiding overload (clipping) for the loudest signal levels 
required from the system (typically the “crash” sound for a flight simulator), this affording 
the maximum signal-to-noise performance, and then setting the amplifier Channel Level 
Controls to achieve the required loudness for this particular sound. Please refer to section 
2.3. in this document for the recommended setup. 

The final setting determined for each Channel Level Control should be documented to allow 
the system to be returned to ‘tuned’ state, should it be necessary to replace the amplifier due 
to failure, or to allow production programs to be identically configured. This may be docu-
mented by counting the detent value selected for each channel.

Note the Channel Level Control is a precision attenuator, and each detent of the control cor-
responds to the following attenuation:

Detent 4/8 Ohm

0 (full CCW) -68.31

1 -67.54

2 -32.23

3 -25.46

4 -21.83

5 -19.23

6 -17.12

7 -15.36

8 -13.76

9 -12.28

10 -10.84

Do not exceed setting 10. 

11 -9.51

12 -8.28

13 -7.09

14 -6.30

15 -4.92

16 -3.82

17 -2.62

18 -1.35

19 -0.01

20 (full CW) 0.00

Attenuation is in dB, attenuation amounts shown may vary ± 6 percent. Level-control Attenuation 
per Detent. 
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Chapter 4: Technical Specifications
4.1. Wiring

Select the appropriate size of the wire based on the distance from the amplifier to the speaker. 

Distance Wire Size

up to 25 ft. (7.6 m) 16 AWG

26-40 ft. (7.9-12.2 m) 14 AWG

41-60 ft. (12.5-18.3 m) 12 AWG

Over 60 ft. (18.3) 10 AWG

Warning: Never connect the speaker return to the chassis of the amplifier, or dam-
age to the amplifier may result. 

Never use shielded cable for output wiring. 

+ +- -

+ +- -

- -

- -
+ +

++

+ +
- -

Figure 8: Output Connector Wiring

Note: Output panel shown with touch-proof cover plate removed. 
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4.2. Voltage Limits

Models
Under-Voltage 

Limit
Over-Voltage 

Limit

120 VAC units 108 VAC 132 VAC

220V / 230V / 240V units 198 VAC 264 VAC

4.3. Performance Specification 

Performance CTs 4200 CTs 8200

Frequency Response (at 1 watt, 20 Hz – 20 kHz) 0.5dB 0.5dB

Signal to Noise Ratio below rated power (20 Hz to 
20 kHz)

100 dB unweighted 100 dB unweighted

Total Harmonic Distortion (THD) at 1 watt, from 
20 Hz to 20 kHz

< 0.05% < 0.5%

Crosstalk (below rated power, 20 Hz to 1 kHz) > 80 dB > 80 dB

Common Mode Rejection (CMR) (20 Hz to 1 kHz) > 50 dB > 50 dB

Load Impedance (Note: Safe with all types of 
loads)
     Stereo 
     Bridge Mono

4/8 and 25 ohms (70V)
8/16 and 50 ohms (100V)

4/8 and 25 ohms (70V)
8/16 and 50 ohms (100V)

Voltage Gain (at maximum level setting), 1.4V 
sensitivity
     4/8 Ohm Operation 20:1 (26 dB) 20:1 (26dB)

Required AC Mains (model dependent) 120V, 60 Hz. 220/ 230/ 240V, 
50 Hz

100V, 50/60 Hz. 120V/60 Hz. 
220/230/240V, 50Hz

Power Draw at Idle (120VAC mains, all channels 
in 4/8 ohm mode)

70W 70W

Power Draw at Idle (120VAC mains, all channels 
in 70V mode)

114W 114W

Cooling Continuously variable speed 
forced air, front-to-back airflow

Continuously variable speed 
forced air, front-to-back airflow

Dimensions: Width, Height, Depth 19 in. (48.3 cm) W x 
3.5 in. (8.9 cm) H x 
16.25 in. (41.3) D

19 in. (48.3 cm) W x 
5.25 in. (13.3 cm) H x 

16.25 in. (41.3) D

Net Weight, Shipping Weight 26 lb. 6 oz. (12 kg), 30 lb. 14 
oz. (14 kg)

36 lb. 6 oz. (16.5 kg), 47 lb. 
(21.3 kg)

Dynamic Range 103 dB typical (A-weighted, 20Hz-20kHz)
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4.4. Minimum Guaranteed Power 

CTs 4200 Minimum Guaranteed Power (in watts, 0.1% THD) 120VAC, 60 Hz units

Dual Mode

Channels Driven 4 2 1

1 kHz 20 Hz - 20 kHz 1 kHz 1 kHz 20 Hz - 20 kHz

4 Ohm 260 215 270 270 225

8 Ohm 180 190 210 220 210

CTs 8200 Minimum Guaranteed Power (in watts, 0.1% THD) 120VAC, 60 Hz units

Dual Mode

Channels Driven 8 4 2 1

1 kHz 20 Hz - 20 kHz 1 kHz 1 kHz 1 kHz 20 Hz - 20 kHz

4 Ohm 200 175 250 260 270 230

8 Ohm 160 155 190 200 220 220
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Chapter 5: References
For more information please read the following Crown® documents: 

• Crown® Operation Manual for CTs 4200 and 8200 Multi-Channel USP/CN Series

• Amplifier Application Guide 

To obtain the latest versions of these documents please visit the Crown® website at www.crown-
audio.com. 

5.1. Crown Amplifier Part Numbers

This document refers to two very specific Crown® amplifiers, if purchasing a Crown® amplifier 
from another source follow the part numbers below to ensure compatibility. Similar part numbers 
that may appear to be the same will not work consistently with ASTi’s ACENet architecture.

Crown Amplifier Part Number

Crown CTS8200 USP/CN GCTS8200AUSPCN

Crown CTS4200 USP/CN GCTS4200AUSPCN
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Appendix A: Crown Amplifier Configuration for 
ACENet Network
Requirements

• Crown® Amp connected to the ACENet Network

• HiQnet System Architect® software (download at http://hiqnet.harmanpro.com). Be sure to 
download the latest version.

• Windows® XP, 2000, 2003 Server, Vista, or Windows 7

• 2 GHz processor or faster (3GHz recommended)

• 2 GB RAM

• Minimum of 400 MB free hard drive space

Note: Do not proceed with configuration while running a project/model on a Target that is con-
nected to the same ACENet network. Disconnect the Target from the ACENet network. 

 1. Open HiQnet System Architect® software.

 2. The following screen will appear the first time a device is recognized on the network. 
Always select “Receive from Device.”
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 3. Navigate to Tools > Network Troubleshooter and select it.

 4. The following screen will appear, select 'Next'. 
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 5. Select the network interface of your computer that is connected to the amplifier and select 
“Next.” 

 6. Wait as the system detects devices over the network. 
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 7. As the system gathers information, the computer syncs the subnet mask of the amp. 

 8. The following screen will appear, select 'Next'.
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 9. The following screen will appear, check the box and select 'Next'.

 10. The following screen will appear, select 'Next'.
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 11. The following screen will appear, select 'Finished'.

The amplifier(s) are now readdressed to be on the same subnet as the computer running 
this software. 

 12. A Crown® Amp icon will appear for each amp on the network. Double-click the Crown® 
Amp to make adjustments. 
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 13. Make adjustments to the amp configuration to set it up for your requirements. 

 14. After making changes, the 'Store' button will illuminate in yellow. Select the 'Store' button 
to save the changes to the preset. 

Important: Keep a close eye on the CPU usage indicators shown in the lower left of the above 
pictures. Adding filters and settings use CPU resources which are finite. Once the CPU usage 
indicators change from green to amber you are dangerously low on CPU capacity. Do not add 
additional filters or use additional features since the amp will likely not enable them. Once the 
CPU use is marginal the “store” button may not work or it may take multiples attempts to make it 
work. 
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 15. Store as Preset 1 and click 'Ok.'

Important: Always save and load files to Preset 1. Preset 1 is the default and will automat-
ically run on the amp after it boots. 

 16. Select File > Save > Preset File. 

 17. Select '1 - Preset 1' and select 'Ok'. 

 18. Click “Select” to configure the filename and path of the saved preset. 

 19. Click “Ok.” 

The configuration is now complete. 
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Opening and Assigning Saved Presets

 1. To open a preset, navigate to File > Open > Preset File. 

 2. Select Preset1.

 3. Check the “Copy preset…” box. 

 4. Select the preset file to load into your selected preset. 

 5. Click “OK.”
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Troubleshooting
Any transparent devices that show up in the main window are devices that have been recognized 
on the network at some point but are not currently connected to the network. Check the amp 
power and ACENet connection. 
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